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LynxEye™ Detector User Manual 

1 Safety Issues 

This manual contains notices which you should follow to ensure your own personal safety, as well as 
to protect the product and connected equipment. These notices are highlighted in the manual by a 
warning triangle and are marked as follows according to the level of danger: 

 
 WARNING 

The word “Warning” indicates that death, severe personal injury or substantial property damage can 
result if proper precautions are not taken. 

 

 
 CAUTION 

The word “Caution” indicates that minor personal injury or property damage can result if proper 
precautions are not taken. 

 

 NOTE 

The word “Note” draws your attention to particularly important information on the product, handling the 
product or to a particular part of the documentation. 
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1.1 Qualified Personnel 
The LynxEye™ may only be set up and operated in conjunction with this manual. Only personnel 
authorized by Bruker AXS is allowed to work on this equipment. All repairs, adjustments and 
alignments performed on any components of the LynxEye must be carried out strictly in accordance 
with the established safety practices and standards of the country where the equipment is installed. 

1.2 Correct Usage 
This device and its components may only be used for the applications described in this manual and 
only in connection with devices or components from other manufacturers which have been approved 
or recommended by Bruker AXS. 

This product can only function correctly and safely if it is transported, stored, set up and installed 
correctly and operated and maintained as recommended by Bruker AXS. Protection provided by this 
equipment may be impaired if it is used in a manner not specified by Bruker AXS. 

1.3 X-ray Equipment 
 

 WARNING 

X-ray equipment produces potentially harmful radiation and can be dangerous to anyone in the 
immediate vicinity unless safety precautions are completely understood and implemented. All persons 
designated to operate or perform maintenance need to be fully trained on the nature of radiation, X-ray 
generating equipment and radiation safety. All users of the X-ray equipment are required to accurately 
monitor X-ray exposure by proper use of X-ray dosimeters. 

 

For safety issues related to the operation and maintenance of your particular X-ray generator, 
diffractometer and shield enclosure, please refer to the manufacturer operation manuals or your 
Radiation Protection Supervisor. The user is responsible for compliance with local safety regulations. 

The LynxEye detector itself is no source generating X-rays, it just senses X-rays. 
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 WARNING 
Voltage Danger - Before installing the detector, switch off the system to avoid high voltages. 

Bias voltages up to 500 V DC are accessible from the outside! They are present on the metal sensor 
window on the front side of the detector! Never operate the detector with Bias voltage switched on 
without having the detector optics mounted! 

Inside the LynxEye, Bias voltages up to 500 V DC can occur which are not accessible from the 
outside. Bias voltages exist inside the detector, the detector controller and in the Detector Power cable 
connecting the detecting unit and the control rack. After turning off the system, Bias voltages are still 
present. They discharge over time. Wait a few minutes before removing cables from the controller unit. 
If one of these Bias-voltage components is damaged, switch off the system immediately and contact 
your local Bruker AXS Service Department. 

 

 

 WARNING 

Sometimes complex D8 systems will be supplied by several power supply lines. The system and its 
components will be live until all power lines connected to the system are disconnected from the mains 
power supply. 
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 CAUTION 

Switching ON/OFF the detector Bias will initiate a ramping process for the Bias voltage. This process 
is indicated by a flashing BIAS READY LED. In all cases wait until the ramping process has finished. 

When switching ON the detector Bias this will be indicated by a steadily lit BIAS READY LED. 

When switching OFF the detector Bias this will be indicated by the BIAS READY LED turning off. 

Any violation of this precaution rule might result in a reduced lifetime or damage of the detector. 

 

 

 CAUTION 

Never touch the metal sensor window of the detector entrance window with fingers or tools. Any partial 
damage on this thin layer might lead to non-repairable malfunctions of the detector, the warranty is not 
valid any more. 

 

 

 CAUTION 

Use care when moving the detector head to avoid mechanical shock to the assembly. 

 



LynxEye Detector User Manual Safety Issues 

DOC-M88-EXX95 V2 – 11.2007 1-5

 

 WARNING 

The mains power for the LynxEye controller commonly connects to X601, located on the left side of 
the D8 base cabinet. 

Pressing the Stop button of the D8 will NOT turn off the three AC outlets (X601) that are located on the 
mains distribution panel! Devices connected to these AC outlets can only be switched off by the 
internal automatic circuit breaker labeled F600 or the external power switch that is installed on the 
user’s side close to the diffractometer. The control panels of the D8 diffraction system are located on 
the front side of the system. X602 is supplied power as long as the D8 On/Off switch (on the right-hand 
column of the D8 cabinet) is enabled and the two emergency Stop switches are not engaged. 

In the event of an emergency, press either Stop button located on the front side columns of the D8 
base cabinet to switch off power to the control electronics and high voltage generator. In case that the 
LynxEye controller is connected to X602 it will also be shut off violating the precaution rules for the 
detector Bias! 

Use the Stop button to immediately shut off power to the X-ray source and stop all moving drives 
instantly. The Stop button should only be used in emergency situations and not for normal shutdown 
of the diffractometer system. 

 

1.4 Proper Lifting 
Installation of the detector requires lifting of components with heavy weight (e.g. enclosure rear panel). 
Whenever possible, two or more people should lift objects together. Use proper lifting techniques at all 
times. Use the following steps as an overview of proper lifting techniques. 

1. Plan: practice the lift. While lifting, bend at the knees, keep your back straight, tighten your stomach 
and lift with your legs. 

2. Position: keep your body close to the object you wish to lift - your stability increases the closer you 
are to the object. Keep your feet shoulder width apart. 

3. Movement: avoid making awkward movements while holding a heavy object. Get help if the object 
is too heavy or cumbersome. 
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2 Introduction 

This manual covers installation and basic operation of the LynxEye detector. The LynxEye is a 
1-dimensional detector for X-ray powder diffraction, based on Bruker AXS’ compound silicon strip 
technology. Compared to a simple point detector the LynxEye dramatically increases measured 
speed – without sacrificing resolution and peak shape. A Diffraction Solution equipped with the 
LynxEye records a typical powder pattern in approximately 1/200th of the time required using a point 
detector, with identical data quality. 

The LynxEye is based on the silicon strip detector technology. The active area of the detector is 14.4 
mm by 16 mm (along the scattering plane respectively perpendicular). The 192 strips of the sensor act 
as 192 individual detectors. This technology allows operation at count rates much higher than those 
typically possible with gaseous detectors while maintaining all benefits. Together with the innovative 
front-end electronics, optimum tuning of the silicon strip sensor to the requirements of the X-ray 
energy from 6 keV to 15 keV is provided. The factory settings are optimized for Cu-K�. 

The LynxEye fits to all Bruker AXS D4 and D8 Diffraction Solutions. It can be easily exchanged by any 
other point, linear or 2-dimensional detector. There is no need for counting gas, cooling water or liquid 
nitrogen, making the LynxEye a compact, robust and maintenance-free detector. 

Supplied with a dedicated software the LynxEye can also be operated as a stand alone solution. 
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3 System Description 

 

Figure 3.1 LynxEye detector 

The LynxEye consists of three coponents which are installed in the D8 system: the detector itself, the 
detector controller, and the optics. This section also contains information on the counterbalance, as 
the setting may vary depending on your configuration. 
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3.1 The Detector 
 

3.1.1 Detector Specifications 

Table 3.1 Basis specifications of the LynxEye 

Detector Specifications  

Suitable systems  All D8 SUPER SPEED SOLUTIONS systems, all 
D8 systems and the D4 ENDEAVOR 

Active area  14.4 mm x 16 mm; (in and perpendicular to the 
scattering plane) 

Max 2-theta range simultaneously covered  4° at 401 mm measurement circle diameter 

Usable wavelength range  From Cr-K� up to Cu-K�, factory-set default for Cu-
K� 

Maximum global count rate  > 100,000,000 cps 

Maximum local count rate (per strip) 650,000 cps 

Energy resolution  25% with 55Fe radiation at 5.9 keV 

Efficiency > 98% (Cu-radiation) 

Spatial resolution (pitch) 75 μm, 192 individual readout channels 

Voltage of power supply  100–240 V AC 

Frequency of power supply  50/60 Hz 

Power rating  100 VA 
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Detector Specifications  

Detector (overall dimensions and weight) 200 mm D x 120 mm W x 120 mm H, 2.5 kg 

Controller (overall dimensions and weight) 420 mm D x 485 mm W x 90 mm H, 8.5 kg 

Length of cables between the detector and 
19” controller chassis unit  

4 m 

Disconnect device  IEC 320 connector/plug on power supply cord 

Software  DIFFRACplus Measurement package version 2.4 or 
higher, for 0-D mode version 2.6 or higher 

Included in delivery  LynxEye detector; front-end read-out and supply 
electronics; mounting and optics assembly, 
including K�-filter, 2.5° Soller slit, 3 mm and 8 mm 
plug-in slits 
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3.1.2 Environmental Ratings 

Table 3.2 shows the range of environmental conditions for which the equipment is designed. 

Table 3.2 Environmental ratings of the detector 

Environmental ratings  

Operating temperature 14–34°C (57–93°F) 

Maximum temperature gradient + 0.5°C (+ 0.9°F) per hour 

Relative humidity Max 80%, non-condensing, for temperatures up to 31°C (88°F) 
decreasing linearly to 50% at 40°C (104°F) 

Location of Indoor use only 

Altitude All terrestrial locations 

Mains supply voltage fluctuations Up to +10% of the nominal voltage 

Over voltage category IEC 664 II 
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3.1.3 Detector Components 

The detector contains the Silicon Strip Sensor, the signal pre-processing electronics (ASICs) and a 
non-volatile memory where all detector specific parameters are stored. 

 

 

Figure 3.2 Block diagram of the detector electronics 
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3.1.4 Detector Cables and Connectors 

The detector has two cable connectors: 

� One connector for the detector power 

� One connector for the detector’s signal outputs 
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3.2 The Detector Controller 
 

3.2.1 Detector controller components 

The detector controller contains the electronic circuit boards for signal processing, the detector bias 
voltage power supply (sensor power supply), power supplies for other detector electronics and a CPU 
running the controller firmware (stored on a flash disk).  

 

 

 

Figure 3.3 Block diagram of the controller electronics (part 1) 
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Figure 3.4 Block diagram of the controller electronics (part 2) 

 

 

All of these units are placed within the same 19" housing. 
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Figure 3.5 Detector controller (outside, front) 

 

 

Figure 3.6 Detector controller (outside, back) 
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3.2.2 Detector Controller Status LEDs 

Table 3.3 shows the different states of the controller’s status LEDs. 

 

LED State 

ALARM 

(red) 
Alarm (lighting permanently) or Warning (blinking) pending. 

SYSTEM ACTIVITY 

(green) 

Blinking LED indicates that the firmware of the LynxEye controller is running. The 
LED stays turned on or off if the firmware has not been started or hangs by any 
reason. 

BIAS READY 

(yellow) 

The bias LED displays the status of the high voltage supply which produces the 
bias voltage for the silicon strip detector. 

� LED off: Bias voltage is turned off. 

� LED blinking: Bias voltage is ramping up or down. 

� LED on: Bias voltage is on and equal to the set value. 

LOW VOLTAGE READY 

(green) 
The LED is turned on when all internal power supplies are OK. If one or more 
supply voltages are not present then the LED will be turned off. 

Table 3.3 States of the controller’s front side LED’s 
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3.3 Detector Optics 
 
 WARNING 

Voltage Danger - Bias voltages up to 500 V DC are accessible from the outside! They are present on 
the metal sensor window on the front side of the detector! Never operate the detector with Bias 
voltage switched on without having the detector optics mounted! 

 

The optics of the detector consists of four components (see Figure 3.7): Axial Soller slit, K� filter, 
Antiscatter tube and plug-in slits. All filters and slits have notches which fix the slit in position when 
properly inserted (see Figure 3.8). The Antiscatter tube length used depends on the measurement 
circle diameter: one for 401 mm (for D4 only), one for 435 mm and one for 500 mm are available (see 
Figure 3.9). See 12 for part numbers. 

 

 

Figure 3.7 LynxEye detector optics 
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Figure 3.8 Plug-in slits and Axial Soller slit Figure 3.9 Antiscatter tubes options 
for different 
measurement circle 
diameters 
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3.3.1 Exchanging the Antiscatter tube 

To optimize the performance of the LynxEye detector the appropriate Antiscatter tube should be used 
for the corresponding measurement circle diameter. For D4 systems only one defined measurement 
circle diameter is used (401 mm). On D8 systems different measurement circle diameters can be 
used, dependent on the application.  

To take this into account Antiscatter tubes for the two most common measurement circle diameters 
are available (435 mm and 500 mm). The Antiscatter tubes are exchangeable. For part numbers see 
12. 

1. Remove 2 screws fixing the Antiscatter tube to the detector (see Figure 3.10). 

2. Slide the optic block out of the guideway of the detector (see Figure 3.11). 

3. Remove 4 screws fixing the plug-in slit holder to the Antiscatter tube (see Figure 3.11). Figure 3.12 
shows the disassembled optic 

4. Re-assemble the parts using the exchanged Antiscatter tube. 
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Figure 3.10 Removing the optics from the 
detector 

Figure 3.11 Slide out the optics block 

 

 

Figure 3.12 Disassembled optics 
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3.4 Counterbalance 
There is no special counterbalance setting required for the LynxEye detector. The standard setting for 
the Scintillation counter should be used. 

 

Please refer to the counterbalance test sheet in the Instrument Supplement folder. 
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4 Hardware Installation in the D8 

This section describes hardware installation for a D8 ADVANCE. 

 

4.1 Servicing Precautions 
 
 WARNING 

Risk of electric shock! 
Some steps of the hardware installation require opening the side panels of the D8 base and accessing 
parts inside. 

When the equipment is connected to the mains supply, some terminals, components, and multiple 
power supply lines may be live. It is not sufficient to just press the D8 base cabinet’s Power OFF 
button (O) or the on/off power switch on the LynxEye controller. The mains supplied to the system 
must be completely switched off externally. 

It is highly recommended that any work on components of or inside the D8 base cabinate is performed 
by Bruker AXS employees only! 

 

 
 CAUTION 

Switch off the LynxEye detector Bias before switching off the LynxEye controller mains power. Wait 
until the BIAS READY LED turned off to make sure that the Bias voltage ramped down completely! 
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 CAUTION 

Components attached to the goniometer will move during operation. 

 

 

4.2 Shipping and Unpacking 
1. Check for external shipping damage to the packages. 

2. Open the boxes containing the detector and its components. 

3. Check for any damage to the components. 

4. Inventory all items for completeness. 

5. Save the packaging when practical for return shipping. 

 

4.3 Baseline Data 
Before making any installation or calibrations to the diffractometer, run and save a standard Bragg-
Brentano scintillation scan using the settings in Table 8.1 or Table 8.2. The data file will be the 
baseline for comparison of the data collected using the LynxEye detector. The baseline data should be 
collected with a standard reference material like the NIST SRM 1976 corundum plate (see the 
Instrument Verification Booklet M88-Zxx041 for additional system parameters). 

 

 NOTE 
For Systems delivered without secondary slit systems the initial alignment of the system has to be 
done with the LynxEye detector in 0-D mode with 10 mm opening for theta and 0.075 mm opening for 
detector to determine the ZI-valus with the glass slit. For additional information about the parameters 
see section 9. 
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4.4 Hardware Installation 
The following sections discuss the integration of the detector in D8 systems in response to 
developments in the area of integrating the second-generation D8 axes indexer board (AIB2G). 

Since March 2005, D8 FOCUS, D8 ADVANCE and D8 DISCOVER systems are equipped with the 
AIB2G (C79298-A3220-B231 and C79298-A3220-B232). 

The location of the LynxEye controller is critical for proper operation. There must be sufficient airflow 
around the controllers to prevent the electronics from overheating. 

Do not place the LynxEye controller in close proximity to the generator. This may induce electronic 
noise in the detector electronics. 

 

 CAUTION 

Use care when moving the detector head to avoid mechanical shock to the assembly. 

 

4.4.1 Mount the Rails 

1. It might become necessary to mount additional rails (part number C79298-A3242-C115), item C in 
Figure 4.1, to accommodate the LynxEye controller. 

2. Relocate the existing rails, A in Figure 4.1, for adequate airflow. 

3. Mount the rails so there is a minimum space of 1" between the LynxEye controller and other 
components. 

4. Mounting the rails requires removing the front and rear columns of the system. Remove the screws 
located at position B in Figure 4.1 to detach the columns. 
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Figure 4.1 Column and rail locations 

 

4.4.2 Install the Controller 

Whenever possible, place the LynxEye controller above the D8 controller electronics. Allow at least 1" 
of open area around the top, bottom, and back of the units for adequate airflow. Remove the D8 front 
and side access panels and blank panels for the installation of the controller. 
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4.4.3 Connect the Cable Wiring 

6 cables are delivered with the complete detector system (see 12 for part numbers) 

� Detector Power cable 

� Detector Data cable 

� Ethernet crossover patch cable with RJ-45 connectors 

� Motor clock cable A17D42 and adapter A17D43 or Multi Axes Clock cable A17D79 

� Mains power cable 

� Ground cable 

 

See Figure 3.6 and Figure 6.1 for the connection of the wiring. Guide the Detector Power cable and 
the Detector Data cable through the safety labyrinth at the back of the D8 enclosure. Make sure that 
no cables will be pinched when closing the back cover. Connect LynxEye controller, control PC and 
D8 system like the configuration shown in Figure 6.1. 

1. Connect Detector Power cable to detector and to controller. 

2. Connect Detector Data cable to detector and to controller. 

3. Take the serial cables that are used to connect the PC and COM 1/COM 2 of the LynxEye 
controller, respectively. 

4. The connection of the motor clock cable (A17D42 or A17D79) differs dependent on system and 
revision of the axes boards: 

4.1. Series 1 axes indexer boards B104/B105: The motor clock cable (A17D42, A17D79 is not 
usable for series 1 boards) with adapter (A17D43) has to be connected between the 9-pin 
STEP/DIR port of the detector controller and either 

� For D8 systems, the X5 9-pin port on the B104 2-axes indexer board, or 

� For D4 systems, the socket on the bracket of the B105 4-axes board. 
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4.2. 2nd generation axes indexer boards (AIB2G) B231/B232: The motor clock cable (A17D42 
or A17D79) without adapter (A17D43) has to be connected between the 9-pin STEP/DIR port 
of the detector controller and either: 

� For D8 systems, the X5 9-pin socket on the B231 2-axes indexer board, or 

� For D4 systems, the socket on the bracket (X11) of the B232 4-axes indexer board. 

 

 
 NOTE 

The clock signal cable can be one of two cables, one straight and one Y-shaped (see Figure 4.2 and 
Figure 4.3). If you are running the system with the AIB2G, NEVER use the Y-shaped adapter cable 
(A17D43) in any case! For additional information about mounting the A17D79 cable see section 9. 

 

 

Figure 4.2 Clock signal cable (A17D42) Figure 4.3 Y-shaped adapter cable 
(A17D43). Note: Use only for 
AIB B104/B105 (series 1). 

 

5. Attach the grounding strap to the ground plate on the left-side panel of the D8 base cabinet. 
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6. Use the network cable to connect the LynxEye controller and the 2nd LAN adapter of the PC. For 
installation and configuration of the 2nd LAN adapter see Sections 6.1 through 6.3. 

 

 

4.4.4 Connect the Power Supply 

Check that the detector controller power cord is connected to X601 on the left side of the D8 base 
cabinet. 

 
 WARNING 

Servicing Precautions - When the equipment is connected to the mains supply, some terminals of the 
mains distribution unit may be live. Therefore, it is absolutely necessary to switch off the external 
mains supply before opening the housings. It is not sufficient to just press the on/off power switch of 
the instrument. 

The mains supply must be switched off externally on the customer’s side (wall socket or external 
switch). 

 

4.4.5 Mount the Detector to the 2-Theta Axis 

The detector replaces the scintillation detector or any other previously installed detector. 

Follow the steps indicated below for assembling mount and detector. Mounts will be available for three 
measuring heights (150 mm, 214 mm and 258 mm). Special mounts for 0/90° orientation of the 
LynxEye are available since 2007 for D8 ADVANCE and D8 DISCOVER diffractometers. See sections 
12 for part numbers. 

1. Check that the setscrew is in the location shown in Figure 4.4. This ensures that the detector is at 
the proper measurement circle diameter. 

2. Fix the mount with two screws to the detector (see Figure 4.5). 



Hardware Installation in the D8 LynxEye Detector User Manual 

 DOC-M88-EXX95 V2 – 11.2007 4-8

 

  

Figure 4.4 Setscrew position Figure 4.5 Detector mounting plate 

 

 

3. Move the 2-theta drive to a position where the detector can be placed on the track (approximately 
35° 2-theta). 
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4. Use Figure 4.6 to set the predefined measurement circle diameter on the theta and 2-theta tracks. 

 

 

Figure 4.6 Predefined measurement circle diameter pin locations 
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5. Place the detector on the track. Slide it down to the pinned position and tighten the track mounting 
screws. 

 

 NOTE 

To confirm the proper measurement circle radius, measure from a point at the center of the sample 
stage (goniometer center) to a point approximately 41 mm behind the front side of the detector cover 
(see Figure 4.7). Use this as a reference when placing the detector on the track. 

 

 

Figure 4.7 Reference for checking the measurement circle radius 

 

6. Move the 2-theta drive through the complete range to make sure the detector moves freely and is 
not restricted by the cables. 

 

41 mm 
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5 Hardware Installation in the D4 

This section describes hardware installation for a D4 ENDEAVOR. The installation of the LynxEye 
detector in the D4 ENDEAVOR is different to the installation in the D8 ADVANCE. The main 
differences are the detector mount and the cabling through the enclosure. 

5.1 Servicing Precautions 
 

 WARNING 

Risk of electric shock! 
Some steps of the hardware installation require opening the side panels of the D4 and accessing parts 
inside. 

When the equipment is connected to the mains supply, some terminals, components and multiple 
power supply lines may be live. It is not sufficient to just press the D4’s Power OFF button (O) or the 
on/off power switch on the LynxEye controller. The mains supplied to the system must be completely 
switched off externally. 

It is highly recommended that any work on components inside the D4 is performed by Bruker AXS 
employees only! 

 

 
 CAUTION 

Switch off the LynxEye detector Bias before switching off the LynxEye controller mains power. Wait 
until the BIAS READY LED turned off to make sure that the Bias voltage ramped down completely! 
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 CAUTION 

Components attached to the goniometer may move during operation. 

 

5.2 Shipping and Unpacking 
1. Check for external shipping damage to the packages. 

2. Open the boxes containing the detector and its components. 

3. Check for any damage to the components.  

4. Inventory all items for completeness. 

5. Where possible, save the packaging for return shipping. 

 

5.3 Baseline Data 
Before doing any installations or calibrations on the diffractometer, run and save a standard Bragg-
Brentano scintillation scan using the settings in Table 8.1 or Table 8.2. The data file will be the 
baseline for comparison of the data collected using the LynxEye detector. The baseline data should be 
collected with a standard reference material like the NIST SRM 1976 corundum plate (see the 
Instrument Verification Booklet M88-Zxx041 for additional system parameters). 
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5.4 Hardware Installation 
The additional electronics mounting rack (incl. a set of rails) must be present to accommodate the 
LynxEye controller in the D4. 

The location of the LynxEye controller is critical for proper operation. There must be sufficient airflow 
around the controller to prevent the electronics from overheating. Do not place the LynxEye controller 
in close proximity to the generator. This may induce electronic noise in the detector electronics. 

 CAUTION 
Use care when moving the detector head to avoid mechanical shock to the assembly. 
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5.4.1 Mount rails and controller 

1. Remove the D4’s left side panel. 

2. Remove the rack for the electronics. 

3. Attach the rack nuts at the positions to mount the LynxEye controller as shown in Figure 5.1. 

 

  

Figure 5.1 Relocate rails and rack nuts Figure 5.2 Controller inside D4 

 

4. Adjust the height of the rails so that the controller can be fixed to the rack nuts (see Figure 5.1). 

5. Take out the controller and mount the rack into the system again. 

6. Mount the controller into the rack (see Figure 5.2). 
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5.4.2 Mounting of detector and cable guide A17B63 

1. Fix the detector to the detector mount with 2 screws (see Figure 5.3). 

2. Fix the sheet angle to the D4 mount with 2 screws (see Figure 5.4). 

 

  

Figure 5.3 Mount the detector to the detector 
mount 

Figure 5.4 Mount sheet angle 
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3. With a piece of tape mark the detector data cable (A17D78) exactly 1 m measured from the 
connector B60-X2 (see Figure 5.5). 

 

 

Figure 5.5 Mark detector data cable 

 

1 mB60-X2 
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4. Remove the transportation lock bar and the rear low cover of the D4. 

 

  

Figure 5.6 Remove transportation lock bar Figure 5.7 Remove rear low cover 
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5. Mount the goniometer top cover (3 screws only!) and the back side shield. 

 

  

Figure 5.8 Mount top cover Figure 5.9 Mount back side shield 

 

 

6. To mount the detector to the goniometer, use two M5 30 mm Torx screws and place the detector 
onto the goniometer. Use the same position as used with the secondary slit system with the 
scintillation counter (see Figure 5.10 and Figure 5.11). 
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Figure 5.10 Detector mounting positions Figure 5.11 Detector mounted 

7. Connect data cable and power cable to the detector. Fix the data cable with a binder to the sheet 
angle and fix the power cable with some binders to the data cable. 

 

  

Figure 5.12 Fix data cable Figure 5.13 Fix power cable 
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8. Route the cables over the top of the goniometer along the back side shield. 

 

Figure 5.14 Route cables (front side view) Figure 5.15 Route cables (rear side view 
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9. Fix the cables with the cable clamp on the goniometer top cover (see Figure 5.16). The correct 
length for the cables to this mounting position is indicated by the tape mark on the detector data 
cable (refer to Figure 5.5) 

10. Fix the cables with a binder to the back side shield. 

 

 

 

Figure 5.16 Fix cables to goniometer Figure 5.17 Fix cables to back side shield 
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11. Route the cables in a wide bow through the lower cable channel and down through the labyrinth. 

 

Figure 5.18 Route cables down through labyrinth 

 

12. Connect all components as shown in Figure 3.6 and Figure 6.1. 

13. Move 2Theta through its whole range and check that the detector cables can move free, are not 
squeezed, are not bent too much or are not rubbing against sharp edges. 

 

 WARNING 

Position additional components, such as the scintillation counter and slit systems, so that no cables or 
components can collide or jam with the sample lift or with 2Theta at low angles. 

 

14. Mount the D4 rear low cover. 
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6 Software Configuration 

This section describes the basic software configuration. 

6.1 Communication Line 
Communications between the D8 controller, LynxEye detector are made via RS232 lines. 
Communications between the Control PC and the LynxEye detector controller are made via a network 
connection. 

The parameters for communication need to be defined by the user and are stored in the device.ini file. 
The DIFFRACplus Configuration program is used to set the parameters. Perform the following steps to 
configure the system (see Figure 6.1 for the cabling scheme). 
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Figure 6.1 Wiring of the LynxEye detector controller 

User’s LAN (OPTIONAL)

COM 1

COM 2

LAN 
LAN 1

LAN 2

COM 1

COM 2

LynxEye Controller Control PC 

D8/D4 Controller 

(crossover 
patch) 

Clock 

Step/Dir 
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6.2 Install the 2nd Network Adapter “LAN 2” in the PC 
An additional network card is required if the PC will be connecting to the customer’s network. The 
second LAN connection is then used to communicate with the LynxEye controller. 

1. Prepare the computer and work area. 

2. Turn off the power and unplug your computer. 

2.1. Do not attempt to open the computer case while it is on. 

2.2. Do not work on components inside of the computer while it is on. 

 
 WARNING 

Risk of electric shock. Do not attempt the installation with power applied to the computer. 

 

3. Open the computer case. Computer cases are held together in different ways – consult your 
computer’s manufacturer for details. 

Removal of retaining screws may be required. 

Some models have plastic snaps at the corners or edges of the case. Release the cover with a 
squeeze or pull. 

4. Select an open expansion slot on the computer’s system board. 

4.1. Remove the cover plate (i.e., blank plate covering the opening). In most cases, the cover plate 
is held in place with a screw. 

4.2. The network card must fit into an appropriate and available expansion slot. 

5. Insert and secure the card. 

5.1. The card should fit fully and squarely into the slot. The card may need to be rocked gently in 
order to get it to seat. 

5.2. Secure the card to the computer case with a screw. 

5.3. Check to make sure you have not dislocated other wiring or components. 
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 CAUTION 

Take care not to damage components of the card or touch the connector edge. The network card and 
its components contain electrostatically sensitive devices. Before touching the network card, the 
servicing person should discharge themselves by touching an earthed, grounded object. 

 

6. Replace the case. Secure any screws. 

7. Turn on your computer and allow it to boot up normally. 
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6.3  Configuration of the 2nd Network Adapter “LAN 2” 
1. Mount the additional PCI network adapter into a free PCI slot in the PC. To install the network card, 

see Section 6.2 

2. Restart the computer. 

3. Windows should recognize the new hardware. If it asks for a diskette that contains the network 
adapter driver, insert the installation CD. 

4. Configure the network adapter. 

4.1. Click Start > Settings > Control Panel > Network and Dial-up Connections. 

4.2. The new network adapter is listed as “Local Area Connection 2.” 

4.3. Right-click on the new adapter and select Properties. A new dialog box will appear (see 
Figure 6.2). 

 

Figure 6.2 Local Area Connection Properties 
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4.4. Select the Internet Protocol (TCP/IP) item and click the Properties button. Another dialog 
box will appear (see Figure 6.3). 

 

Figure 6.3 Internet Protocol (TCP/IP) Properties 

 

4.5. Select the “Use the following IP address” radio button and enter 192.168.23.1 for the IP 
address and 255.255.255.0 for the Subnet mask. Leave all other fields blank. 

4.6. Confirm and close both dialog boxes by clicking OK in each box. 

The control PC’s network adapter is now configured. 
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6.4 Detector Configuration 
Open the Configuration program (Config.exe) located in the C:\Diffplus directory. 

 

1. From the main Config menu, select the Detectors menu (Figure 6.4). 

2. Check the Position Sensitive Detector checkbox. 

3. Set the PSD type to LynxEye. 

4. Click OK. 

 

Figure 6.4 Detector menu in Configuration program 

5. Select LynxEye (see Figure 6.5) 
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6. Click Default and confirm the following warning. This will set parameters useable for any detector 
and standard applications. 

 

 NOTE 

All relevant detector specific parameters are factory set and stored in the detector’s permanent 
memory. 

 

7. Select the correct distances for Detector Slit (18.8 mm) and Antiscattering Slit (91.1 mm or 
98.2 mm or 130.6 mm dependent on the measurement circle diameter (see Figure 6.5) 

8. Click OK. 

 

Figure 6.5 LynxEye menu 
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6.5  2nd Generation Axes Indexer Boards (AIB2G) Configuration 
 

 

 NOTE 

In case that series 1 axes indexer boards (B104/B105) are in use only basic functions of the LynxEye 
detector will be available. To get unlimited access to all functions of the LynxEye detector the system 
needs to be upgraded with the 2nd Generation Axes Indexer Boards (AIB2G) B231/B232. 

Please proceed with Section 6.6 in case that still old axes indexer boards are in use. 

 

Under Motorized Drives, select B231/232 from the “AIB Type” drop-down menu (Figure 6.6). This is 
standard for Theta-Theta or Theta-2Theta configurations. 
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Figure 6.6 Motorized Drives section 
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6.5.1 Automated installation for AIB2G 

The system can be set to configure itself automatically with regard to the source for the Clock Signal. 

1. Open the Configuration software and select the LynxEye window (Figure 6.7). 

2. Check the Automatic Drive Configuration for Drive/Detector Synchronization (B231/232 only) 
checkbox. 

 

Figure 6.7 Activation of the Automatic Drive Configuration 

After the next download, the source of the Clock Signal is set automatically for Theta-Theta or 
Theta-2Theta configurations. 

If automatic installation was successful, you can skip the following steps regarding manual installation. 
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6.5.2 Manual Installation for Theta-Theta Configuration 

The following sections will describe the settings for different goniometer configurations in case that a 
manual configuration will be done. Anyhow, the use of automated installation for the Clock Signal is 
recommended (see Section 6.5.1). 

1. Make sure that the Automatic Drive Configuration is disabled by unchecking the checkbox in Figure 
6.7. 

2. Select Advanced Board Setup > OK, Show Dialogs > Two Axes Indexer Boards. Ensure that 
physical drive 1 is connected to logical axis TH-Detector, and physical drive 2 is connected to 
logical axis TH-Tube (see Figure 6.8). 

 

 

Figure 6.8 Manual settings for TH-TH 



LynxEye Detector User Manual Software Configuration 

DOC-M88-EXX95 V2 – 11.2007 6-13

3. Select Motorized Drives > TH-Detector. Click Change Values. 

 

 

Figure 6.9 TH-Detector - change values 

4. Answer Yes to the confirmation message and click Additional Settings. The following box 
appears (Figure 6.10). Select the axis that should deliver the Clock signal. Because the logical axis 
TH-Detector is sending the clock signals, this motor axis has to be chosen. From Figure 6.8, the 
“Axis” must be Driver 1. Set “Register” to Signal Status Register and “Bit” to 
(bit 11) Motor Clock – Bit 3. 
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5. Also check the settings of the logical axis TH-Tube in the same way. The parameters for “Sources 
for AxisOUT” must look like Figure 6.11. 

 

  

Figure 6.10 Motorized Drives section  
TH-Detector -Advanced 
Configuration 

Figure 6.11 Motorized Drives section  
TH-Tube - Advanced 
Configuration 

 

 

6. Save and download the configuration. 
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6.5.3 Manual Installation for Theta-2Theta Configuration 

The following sections will describe the settings for different goniometer configurations in case that a 
manual configuration will be done. Anyhow, the use of automated installation for the Clock Signal is 
recommended (see Section 6.5.1). 

1. Make sure that the Automatic Drive Configuration is disabled by unchecking the checkbox in Figure 
6.7. 

2. Select Advanced Board Setup > Two Axes Indexer Boards. Ensure that physical drive 1 is 
connected to logical axis THETA, and physical drive 2 is connected to logical axis 2THETA (see 
Figure 6.12). 

 

 

Figure 6.12 Advanced Board Settings - Two Axes Indexer Board. Settings for Theta-2Theta 
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3. Select Motorized Drives > Theta. Click Change Values. 

4. Answer Yes to the confirmation message and click Additional Settings. The following box 
appears (see Figure 6.13). The “Axis” must be set to Driver 2. Set “Register” to 
Signal Status Register and “Bit” to (bit 11) Motor Clock - Bit 3. 

5. Check the settings for “2Theta”. The parameters for “Sources for AxisOUT” have to look like 
Figure 6.14. 

  

Figure 6.13 Motorized Drives section Theta - 
Advanced Configuration 

Figure 6.14 Motorized Drives section 2Theta - 
Advanced Configuration 

 

 

 NOTE 

Don’t worry about the fact that the settings for “2Theta” don’t show values for “Register” and “Bit”. 

 

6. Save and download the configuration. 
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6.6 Network Configuration 
1. The Advanced Board Setup menu, located in the Configuration program, must be completed prior 

to saving and downloading the configuration file. 

2. Go to Advanced Board Setup > PSD-Controller. 

2.1. In Communication Topology, select Network and press the button Default Network Settings. 

2.2. In Serial Communication Parameters, ensure that Determine Automatically is selected. 

2.3. Click OK. 

 

 

Figure 6.15 PSD Controller menu 
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3. Go to IP Setup and Services (see Figure 6.16). 

3.1. In IP Setup, select the Static Address Assignment radio button. 

3.2. Enter the Host IP Address 192.168.23.2 and the Netmask 255.255.255.0. Do not change any 
other values. 

 

 

Figure 6.16 IP setup 

 

3.3. For upgrade or troubleshooting purposes the HTTP Interface has to be enabled and users 
have to be defined. Refer to Appendix A.1. 

3.4. Click OK. 
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6.7 Computer Port Configuration 
1. In Config, go to Computer Ports (see Figure 6.17). 

 

 

Figure 6.17 Computer port configuration 

 

2. In Computer Ports, select Settings under Diffractometer. 

2.1. In the pop-up window, select TCP/IP as the connection type. 

2.2. Enter the IP address 192.168.23.2 and the port 4251 (see Figure 6.18) 

2.3. Click OK and close the window. 
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3. In Computer Ports, select Settings under PSD Controller. 

3.1. In the pop-up window, select TCP/IP as the connection type. 

3.2. Enter the IP address 192.168.23.2 and the port 4250 (see Figure 6.19). 

3.3. Click OK and close the window. 

 

  

Figure 6.18 Diffractometer > Settings pop-up 
window 

Figure 6.19 PSD controller > Settings pop-up 
window 

 

4. In Computer Port Configuration, click OK to accept the changes (see Figure 6.17). 

5. To activate the configuration, go to File > Save and Download or click the CNF icon. 

6. In the Save and Download pop-up window, ensure that all boxes are checked. 
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Figure 6.20 Save and Download pop-up window 

 

7. Check that the LynxEye controller and the diffractometer are switched on and connected according 
to Figure 6.1. 

8. Click OK to download. 
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7 Motorized Antiscatter slit (Lynx Iris) 

  

Figure 7.1 Motorized Antiscatter slit (Lynx Iris) 

 

The Lynx Iris (A17B70) for the LynxEye detector is a device to control the opening of the 
1-dimensional detector in the diffraction plane via software. It replaces the Fixed Slit assembly and 
allows full flexibility for the detector aperture. The opening of the Lynx Iris can be selected under 
computer control with respect to the measurement range. 
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7.1 Hardware Installation 
1. Switch off the D8/D4. 

2. Switch off the LynxEye BIAS. After the BIAS has ramped down switch off the LynxEye controller. 

3. Disconnect the cables from the LynxEye detector. Remove the LynxEye detector from the detector 
track/goniometer. 

4. Remove the front side slit holder from the Antiscatter tube (see Figure 7.2 and Figure 7.3). 

 

  

Figure 7.2 Removing the slit holder from the 
Antiscatter tube 

Figure 7.3 Slit holder removed 

 

Remove 4 screws (2 top 
side, 2 bottom side) 
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5. Note the values for the reference position and the upper limit from the label on the Lynx Iris (see 
Figure 7.4). 

6. Mount the Lynx Iris to the Antiscatter tube (see Figure 7.5). 

 

  

Figure 7.4 Note zero position values and 
upper limit values 

Figure 7.5 Lynx Iris mounted 

7. Mount the LynxEye detector back on the detector track/goniometer. 

8. Connect the power cable and the data cable to the LynxEye detector. 

9. Route the Lynx Iris cable in a proper way down to the D8/D4 controller. 

10. Connect the Lynx Iris cable to a free driver output of a 4 Axes Indexer Boards. 

11. Restart the D8/D4 and the LynxEye controller. 



Calibration LynxEye™ Detector User Manual 

 DOC-M88-EXX95 V2 – 11.2007 7-4

12. Move the detector circle through its whole range and check that the detector cables and the 
Lynx Iris cable can move free, are not squeezed, are not bent too much or are not rubbing against 
sharp edges. 
In case of collision risks please adjust the software limits using the DIFFRACplus configation 
program. 

 

  

Figure 7.6 LynxEye detector with Lynx Iris mounted in a D8 
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7.2 Software Configuration 
 

7.2.1 Series 1 4 Axes Indexer Boards (4AIB) 

Open the Configuration program (Config.exe) located in the C:\Diffplus directory. 

1. Within the Motorized Drives section select Lynx Iris in the Disabled Drives box. Click on Add to 
move the device to the Enabled Drives box (see Figure 7.7). 

 

 

Figure 7.7 Motorized Drives > Define AUX Drive 
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2. Click OK to apply the changes in this section. 

3. Activate the new defined Lynx Iris and press Default to preset all motor parameters (A) (see Figure 
7.8). 

4. For Zero Reference (B) and Upper Limit (C) refer to the values named Index Mark Off noted in 
Section 7.1 (see also Figure 7.4). 

 

Figure 7.8 Lynx Iris Parameters 

5. Click on Change Values (D) to get access to advanced parameters. 

6. Click on Switches (E) and check the parameters as shown in Figure 7.9. 

A

B

C 

E

D
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Figure 7.9 Switches 
 

 
 
7. Check that the resulting switch code is: 2880EC0. 

8. Close all windows by clicking OK. 

9. Click OK to apply the changes in this section. 
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10. Within the Advanced Board Setup>Four Axes Indexer Boards section assign the physical 
connection of the Lynx Iris established in Section 7.1 item 10 (see Figure 7.10). 

 

 

Figure 7.10 Assign the connection of the Lynx Iris 

11. Click OK to apply the changes in this section. 

12. Save and Download to Diffractometer and LynxEye controller. 
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7.2.2 2nd Generation 4 Axes Indexer Boards (4AIB2G) 

Open the Configuration program (Config.exe) located in the C:\Diffplus directory. 

1. Within the Motorized Drives section select Lynx Iris in the Disabled Drives box. Click on Add to 
move the device to the Enabled Drives box (see Figure 7.11). 

 

 
 
Figure 7.11 Motorized Drives > Define Lynx Iris 
 
 

2. Click OK to apply the changes in this section. 
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3. Activate the new defined Lynx Iris and press Default to preset all motor parameters (A) (see Figure 
7.12) 

4. For Zero Reference (B) and Upper Limit (C) refer to the values named Index Mark Off noted in 
Section 7.1 (see also Figure 7.4). 

  

Figure 7.12 Lynx Iris Parameters 

5. Click on Change Values (D) to get access to advanced parameters. 

6. Click on Switches (E) and check the parameters in the four tabs as shown in Figure 7.13 to Figure 
7.16. 

C 

B

A 
D

E
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Figure 7.13 Conf X Settings Figure 7.14 Conf A Settings 

  

Figure 7.15 Conf B Settings Figure 7.16 Current Control Settings 
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7. Check that the resulting switch code is: 9460,0A38,0000. 

8. Within the Advanced Board Setup>Four Axes Indexer Boards section assign the physical 
connection of the Lynx Iris established in Section 7.1 item 10 (see Figure 7.17). 

 

 

Figure 7.17 Assign the connection of the Lynx Iris 

9. Click OK to apply the changes in this section. 

10. Save and Download to Diffractometer and LynxEye controller. 
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7.3 Alignment 
 

 NOTE 

Following alignment procedure for the Motorized Antiscatter Slit (Lynx Iris) assumes a proper aligned 
D8/D4. 

 

1. Run a PSD Calibration (see Section 8.2). 

 

 NOTE 

Within the Drive section of the XRD Wizard set the Lynx Iris drive to 14 mm. 

 

2. Mount the glass slit. 

3. Move Theta and 2Theta to 0°. 

4. Set generator to 20 kV and 5 mA. 

5. Close the Lynx Iris to 5 mm. 

6. Measure the intensity using the XRD Commander ratemeter (Diffractometer>Ratemeter or            ) 

7. With one millimeter at a time step down to the final measurement of 1 mm and measure the 
intensity until you find an intensity decrease. 

8. Using the alignment screw of the Lynx Iris (B) (see Figure 7.18) optimize to a position where you 
get maximum intensity. 
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 WARNING 

Do NOT touch the dove tail screws (A) of the Lynx Iris. Any try of turning the screws might lead to 
damage. 

 

 

Figure 7.18 Dove tail screws (A) and alignment screw (B) 

9. Continue closing the Lynx Iris in steps of 0.1 mm down to 0.2 mm and align the Lynx Iris to 
maximum intensity. 

 

B 

A 
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7.4 Basic Operations 
XRD Commander is the main measurement program in the DIFFRACplus suite. It can be used to 
perform immediate measurements to get a quick overview of a sample, as well as to perform batch 
measurements using jobs. Operation details for XRD Commander are described in the DIFFRACplus 
XRD Commander User Manual (M88-Exx060). This section will just give an overview of operating the 
Lynx Iris. 

To open the XRD Commander program: 

1. Locate the C:\diffplus directory. 

2. Double-click on the XRDCMD icon. There may be icons set up on the desktop to open the 
XRD Commander program, as well as in the DIFFRACplus Measurement folder in the Windows 
Programs menu. 

3. Within the XRD Commander window click on Aux to get access to the additionally defined drives 
(see Figure 7.19). 

 

The Lynx Iris can be handled similar to all other standard drives (Init Drives, Move Drives). The base 
unit is [mm]. 

 

 NOTE 

When using series 1 4 Axes Indexer Boards (4AIB) it is recommended to move the Lynx Iris first to 
0.3 mm, then to a position below the measurement position, and then to the measuremnt poisition 
finally. This is useful to compensate backlash effects. 

When using 2nd generation 4 Axes Indexer Boards (4AIB2G) this is automatically controlled by the D8 
firmware. 

 

To determine optimized positions for the Lynx Iris dependent on detector geometry angle, divergence, 
measurement diameter, … refer to Section 10.7. 
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Figure 7.19 XRD Commander>Auxiliary Drives 
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8 Calibration 

Prior to calibration, the system must be aligned using the scintillation detector. 

Each detector and the associated electronics are unique. A calibration process is used in conjunction 
with standard reference materials to determine a zero offset for the resolution in degrees. This value 
represents the angular difference between the zero angle of 2-theta and the zero channel of the PSD. 
The calibration program will refine the values and record them in the Configuration program. 

8.1 Check Positional Calibration 
1. Remove all plug-in slits from the detector optic. 

2. Ensure that the proper K� filter and the 2.5° Soller slit are in place. 

3. Ensure that the reference material is mounted (Quartz or NIST 1976) in the sample stage. 

4. Set the goniometer to the parameters in Table 8.1 or Table 8.2 using DIFFRACplus 
XRD Commander. 

 

 NOTE 

Do not close DIFFRACplus XRD Commander. Instead, minimize the window. 
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Goniometer Divergence slit Generator 
settings 

Scan 
parameters 

Scan speed 

Radiation Theta/Theta Theta/2-Theta Variable Fixed 
(mm) 

K� 
filter 

kV mA Increment PSD 
fixed 
(sec) 

Scinti 
(s/step) 

Cr 20.03 20.03 20.03 40.06 0.3° 0.6 V 35 45 0.006 10 0.002 

Co 15.52 15.52 15.52 31.04 0.3° 0.6 Fe 35 45 0.006 10 0.002 

Cu 13.32 13.32 13.32 26.64 0.3° 0.6 Ni 40 40 0.006 10 0.002 

Table 8.1 Parameters for Quartz standard reference 

 

 

Goniometer Divergence slit Generator 
settings 

Scan 
parameters 

Scan speed 

Radiation Theta/Theta Theta/2-Theta Variable Fixed 
(mm) 

K� 
filter 

kV mA Increment PSD 
fixed 
(sec) 

Scinti 
(s/step) 

Cr 26.67 26.67 26.67 53.34 0.3° 0.6 V 35 45 0.006 10 0.002 

Co 20.52 20.52 20.52 41.05 0.3° 0.6 Fe 35 45 0.006 10 0.002 

Cu 17.57 17.57 17.57 35.15 0.3° 0.6 Ni 40 40 0.006 10 0.002 

Table 8.2 Parameters for NIST 1976 standard reference 
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8.2 PSD Calibration 
 

8.2.1 Create Files 

1. Open XRD Wizard from C:\Diffplus\XRDWizard.exe. 

2. Select File and New to display the file types available. This window creates the DQL used for 
calibration. 

3. Select PSDCalib from the new menu files. Click OK (see Figure 8.1). 

 

 

Figure 8.1 XRD Wizard > File > New 

4. To create the DQL file, input the calibration parameters and click OK. The number of positions may 
be nine or larger. Whenever possible, select rotation ON and set the speed at 15 rpm. 

5. Determine the theoretical 2-theta values using Table 8.1 or Table 8.2. Input the values into the 
Calibration Parameters screen (see Figure 8.2). 

6. Input a step size of 0.3. 

 
 NOTE 

For measurements circles larger than 500 mm use 2-theta range 2° and a step size of 0.2°. 
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 NOTE 

When using the Motorized Antiscatter Slit (Lynx Iris) set the position to maximum (� 14 mm) in the 
Drive section of the XRD Wizard. 

 

7. Save the DQL file as Calib.DQL and exit XRD Wizard. 

 

 

Figure 8.2 Create the DQL file. Example shown is for Corundum sample and Cu radiation 
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8.2.2 Collect Data 

1. Open DIFFRACplus XRD Commander. 

2. Select the Jobs tab and create a job using the Calib.DQL file. 

3. Name the RAW file Calib.raw. 

4. Make sure that MeasureV4.VBS is selected as the script to be used. 

5. Press Start Job and wait for the job to finish. 

 

 NOTE 

If desired, you can save this job for future calibrations. 
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8.2.3 Analyze Data 

1. After creating Calib.raw, select Analyze Calibration in the Configuration program under the 
LynxEye menu (see Figure 8.3). 

2. Use the Browse button to locate the RAW file saved during the measurement of the CALIB.DQL. 

3. Press Apply to analyze the calibration and set the resolution and offset of the detector (see Figure 
8.4). 

 

 

Figure 8.3 Analyze the calibration 
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Figure 8.4 Locate the RAW file and apply new calculated values 

 

4. Ensure that the mode zero offset value is approximately -3 to -1. Resolution should be 
approximately 0.020. 

5. Recalibrate if the standard deviation is larger than 0.05°. Continue on to the next step when you 
have reached a standard deviation of less than 0.05° (i.e., zero offset is approximately -3 to -1 and 
standard deviation is less than 0.05). 

6. After changing the detector parameters save and download the new configuration. 

The calibration is now complete. 

After analyzing the calibration file and prior to executing a measurement, optimize the detector optics 
using the Calculate Geometry menu in the LynxEye menu (see Section 10.7). 
 
 
 
 

 NOTE 

Whenever changes have been made in the configuration, remember to restart the Measurement 
server! 
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9 0D-Mode 

This section describes the operation and parts of the 0D-Mode which are available since end of 2007. 
Additional hard- and software is required to fully support this modus. Full support is only achieved with 
new Axes Indexer Boards (C79298A3220-B231 and –B232) , combined with the Multi Axes Clock 
Cable (A17D79) and the 0/90° Mounts for 150mm (A17B81), 214mm (A17B82) and 258 mm (A17B83, 
consisting of A17B82 plus a spacer of 44 mm).  

In 0D-mode a variable block of strips can be defined by software. All events collected by these strips 
are counted as one single rate at a specific angular position – similar to a scintillation counter.The 
most benefit can be achieved with the aid of a special detector holder (0/90° mount) by using the 90° 
rotated position (around the diffracted beam) in combination with a standard 0-dimensional optics. In 
this case, the line intensity is distributed to up to 192 strips of 75 μm width which results in detectable 
count rates of some 100 kcps. This will give the option to measure some 10 million cps. Even if in 
most cases not needed, the LynxEye in 0-D Mode can be combined with the Automatic or Rotary 
Absorber in Auto Mode. 

Continuous and Step Scans are supported for all motors configured in combination with up to 3 Axes 
Indexer Boards. With Series 1 Axes Indexer Boards only Continuous Scan is available for either the 
Tube or Detector axis, depending on where the motor clock events are generated from. 
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9.1 Premises for 0-D mode 
Full support of the 0-D for Step and Continuous Scan for motors connected to up to 3 Axes Indexer 
Boards requires a D8 Series 2 with: 

1. D8 Firmware version 3.06 or 5.02 Release 11/2006, D4 Firmware version 2.02 

2. MeasPart Version 2.6 Release 2007 

3. LynxEye Firmware Version 0.86  

4. Eva Version 13 Release 2007 

5. Multi Axes Clock Cable A17D79 

 

 NOTE 

Clock pulses of 2nd generation Axes Indexer Board are only generated, if a drive is assigned to driver 1
of this board, even if this drive is not intended for the 0-D mode scans with the LynxEye detector! 

 

With the standard clock cable A17D42, only Continuous Scans with tube and detector are possible 
which allows a complete alignment of the diffractometer (without Scintillation counter). Locked coupled 
scans and some others with the these two drives will work in Continuous Mode only. This is important 
for D4 and D8 Focus diffractometers where only the standard clock cable A17D42 will be delivered. 
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9.2 Detector Components for 0-D mode 
In addition to the standard configuration some more parts are available for use with the 0-D Mode: 

� Plug-in Absorber (A17B53, Figure 9.1) 

 

Figure 9.1 Plug-in Absorber 0.1mm Cu 

� Multi Axes Clock cable (A17D79, Figure 9.2) 

 

Figure 9.2 Multi Axes Clock Cable A17D79 

X5 

Clock

X5

X5

B114-X15 B114-X15II



Basic Operation LynxEye Detector User Manual 

 DOC-M88-EXX95 V2 – 11.2007 9-4

All three X5 plugs are identical, unused plugs can be left free. Plug B114-X15 is required for step 
scans. The free length B114-X15II can be used for additional parts like video microscope or additional 
X-ray shutter open display. The clock plug has to be connected to the Motor clock socket (see Figure 
3.6). Connections to the Axes Indexer Boards and the I/O Board B114 are shown in Figure 9.3. 

 

Figure 9.3 Connection of the Multi Axes Clock cable to the D8 Controller boards. 

X5

X5X5

B114-X15 

B232 B232 B231
B114 
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� 0/90° Mount with adapters for different measurement heights, Figure 9.4 

 

Figure 9.4 Mounts for different measurement heights. 

These mounts allow a reproducible switching between 0 to 90°. In 90° position high count rates are 
possible but without a defined angular resolution in 2theta. To compensate this additional secondary 
optics might be required. 

150 mm

214 mm

258 mm

Fixing Screw 
for Detector

Guide Pins 

Holes for 
Guide Pins 

0/90° Base 
plate 
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9.2.1 Mounting the detector using the 0/90° Mount 

 
1. Fix the 0/90° Base plate to the LynxEye detector. See Figure 9.5 

 

Figure 9.5 Fixing the LynxEye detector to the 0/90° Base plate. 

Fixing Screws for 
Detector to 0/90° 
mount angle 
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2. Fix the detector unit (detector + 0/90° base plate) to the spacer either in 0° or in 90°. The pair of 
guide pins of the spacer will fit to the appropriate holes of the 0/90° Base plate. See Figure 9.6. 

 

 

Figure 9.6 Mounting the detector with 0/90° Base plate to the detector spacer. 

 

Spacer 
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The mounting position shown in Figure 9.6 is the standard one for e.g. powder diffraction. The detector 
angle is resting on three balls, which allow a precise and reproducible mounting for 0° and 90° 
position. 

The setup for e.g. Reflectometry Measurements requires a standard secondary optics system in 
addition to the 0/90° holder (to make use of the high count rate mode). A setup with the fixed slit optics 
(diffracted beam slit assembly) for high count rate mode with 90° mounted LynxEye is shown in Figure 
9.7. No Soller should be inserted for the LynxEye because one is used in the Slit assembly. 

 

Figure 9.7 Detector setup for high count rates with Slit assembly and LynxEye in 90° mode. 
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9.3 Performing scans in 0-D Mode using XRD Commander and 
XRD Wizard 

 

9.3.1 Standard operation 

0-D Mode does not require a special setting for the LynxEye in the configuration of the diffractometer. 
Since release 2.6 of the Measurement Part this mode is supported by the XRD Commander and the 
XRD Wizard. When selecting the Details button in the XRD Commander two buttons are available for 
the PSD under Scanning Mode (see Figure 9.8). 

The default mode is ‘1D’. After clicking the 0D button a value for Opening has to be defined,(unit is 
mm). See Figure 9.8. The smallest possible value is 0.075 mm, corresponding to one strip. Odd 
multiples of 0.075 mm can be selected up to a complete opening of approximately 14 mm (depending 
slightly on the centre position of the LynxEye detector). 

All Scan types as for the Scintillation counter or the Sol-X detector are available, see Figure 9.9. Also 
both scan modi (Step scan and Continuous) are possible. 
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Figure 9.8 Detector Opening selection for 0-D Mode. 
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Figure 9.9 Scan Type selection for 0-D Mode in Commander. 



Basic Operation LynxEye Detector User Manual 

 DOC-M88-EXX95 V2 – 11.2007 9-12

 

In the XRD Wizard the 0-D mode can be selected under Detector selection. The detector opening 
can be chosen in the same way as in the XRD Commander. Afterwards all scans known for the 
Scintillation counter are available in Scan Types under Scan Parameters (Figure 9.10). 

 

Figure 9.10 Detector and Opening Selection for O-D mode in Wizard. 
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9.3.2 Systems without Scintillation counter 

The additional 0D functionality now allows to align the diffractometer without a scintillation counter and 
without the additional secondary optics: 

� For Tube Scans the large opening of the scintillation counter has to be simulated by setting the 
LynxEye opening to 10mm. 

� For Detector Scans the smallest LynxEye opening of 0.075 mm should be used to simulate a small 
detector slit. 

� Under these conditions, the ZI values for the Tube and Detector can be determined as known for 
scintillations counters for Th/Th diffractometers. Refer to the ‘User’s Manual for D8 ADVANCE and 
D8 DISCOVER’. 

 

 NOTE 
It is recommended to start the alignment of the diffractometer with the default values set for the 
LynxEye detector in the Configuration program (Config.exe). See section 6.4.  
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10 Basic Operation 

This section covers the power-up, power-down, and basic operation procedures for the LynxEye 
detector system and gives an overview of system operation and collection of data. Operation details 
for XRD Commander are described in the document M88-Exx060. 

 

 WARNING 

The instrument Stop button will not turn off the three AC outlets (X601) that are located on the mains 
distribution panel! Devices connected to these AC outlets can only be switched off by the internal 
automatic circuit breaker labeled F600 or the external power switch that is installed on the user’s side 
close to the diffractometer. 

 

10.1 LynxEye Power-Up Procedure 
1. Press the I/O switch on the rear of the LynxEye controller to apply mains power. Low Voltage 

Ready LED illuminates when power is present. If the Low Voltage Ready LED doesn’t illuminate, 
ensure that there is power applied to the D8 system by pressing the Power ON ( I ) button located 
on the right side column of the D8 base cabinet. 

2. Turn on the Bias for the detector by pressing the Bias enable button on the front of the LynxEye 
controller. 

 

 CAUTION 

After switching on the detector Bias wait until the BIAS READY LED stays lit to make sure that the 
Bias voltage ramped up completely! 
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3. If power and communications for the controller are properly applied, there should be no warning 
LED illuminated. The System activity LED will flash green, indicating communication and control. 
The Bias ready LED will be yellow and illuminated. The Low voltage ready LED will be green and 
illuminated. 

 

10.2 LynxEye Power-Down Procedure 
 
 CAUTION 

Switch off the LynxEye detector Bias before switching off the LynxEye controller mains power. Wait 
until the BIAS READY LED turned off to make sure that the Bias voltage ramped down completely! 

 

1. Before switching off the diffraction system, reduce the high voltage and current of the generator to 
the lowest values (e.g., 20 kV/ 5 mA) using the control software (e.g., XRD Commander). 

2. Turn off the high voltage generator by turning the rotary switch “High Voltage” to the left side. The 
X-RAY ON displays will turn off. 

3. Press the Bias enable button on the front of the LynxEye controller. If the Bias enable button is not 
illuminated, this indicates that bias for the detector is OFF. 

4. Press the I/O switch on the rear of the LynxEye controller to switch off the mains power. 

5. Press the Power OFF button (O) on the D8 base cabinet’s right-hand column to stop power to the 
control electronics, high voltage generator, and the LynxEye controller, when the controller is 
connected to X602. 

6. Switch off the instrument by pressing the D8 base cabinet’s Power OFF button. 

 

 CAUTION 

Failure to reduce the generator high voltage and current prior to shutting off the D8 could significantly 
reduce the lifetime of the X-ray tube and the high voltage generator. 
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10.3 Emergency Power-Down Procedure 
The mains power for the LynxEye controller normally is connected to X601, located on the left side of 
the D8 base cabinet. 

 

 WARNING 

The instrument Stop button will not turn off the three AC outlets (X601) that are located on the mains 
distribution panel! Devices connected to these AC outlets can only be switched off by the internal 
automatic circuit breaker labeled F600 or the external power switch that is installed on the user’s side 
close to the diffractometer. The control panels of the D8 diffraction system are located on the front side 
of the system. X602 is supplied power as long as the D8 On/Off switch (on the right-hand column of 
the D8 cabinet) is enabled and the two emergency Stop switches are not engaged. 

 

1. In the event of an emergency, press either Stop button located on the front side columns to switch 
off power to the control electronics and high voltage generator. In case that the LynxEye controller 
is connected to X602 it will also be shut off violating the precaution rules for the detector Bias! 

Use the Stop button to immediately shut off power to the X-ray source and stop all moving drives 
instantly. The Stop button should only be used in emergency situations and not for normal 
shutdown of the diffractometer system. 

2. To disengage the Stop button, turn the button clockwise and release. Re-apply power with the 
Power On button that is on the right side column of the D8 base cabinet. 
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10.4 Disconnecting the Power Plug 
To remove, relocate or service the LynxEye detector controller, it may be necessary to disconnect the 
power cord from the rear of the controller. 

1. Ensure that all power is off to the enclosure prior to removing the power cord. 

2. Remove the rear access panel of the D8 base cabinet when removing the panel as the ventilation 
fans are connected to it. 

3. Visually inspect the power cord for frayed or exposed wiring prior to removal. If the power cord 
appears defective, contact Bruker AXS Service for replacement by qualified service personnel. 

4. With the access panel removed, firmly grasp the power cord of the detector controller at the strain 
relief and pull the cord from the controller. 

5. The power cord is connected to X601 on the left side of the D8 base cabinet. Pull the plug from this 
outlet strip. 

 

10.5 Lock Out 
Use the key located on the left side column of the D8 base cabinet to lock and unlock the system. 

During normal operation, the key must be switched to the unlocked position. In the unlocked position, 
power may be applied with the ON button located on the right-hand column of the D8 base cabinet. In 
the locked position, no power will be available for the control electronics, generator or X602 
connectors. The key can only be removed in the locked position. 

 
 CAUTION 

Power will still be present at the X601 connectors and some other distribution panels. Electric shock 
can result if proper safety precautions are not observed. 
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10.6 Performing a Measurement 
XRD Commander is the main measurement program in the DIFFRACplus suite. It can be used to 
perform immediate measurements to get a quick overview of a sample, as well as to perform batch 
measurements using jobs. Operation details for XRD Commander are described in the DIFFRACplus 
XRD Commander User Manual (M88-Exx060). This section gives an overview of the system operation 
and collection of data. 

To open the XRD Commander program: 

1. Locate the C:\diffplus directory. 

2. Double-click on the XRDCMD icon. There may be icons set up on the desktop to open the 
XRD Commander program, as well as in the DIFFRACplus Measurement folder in the Windows 
Programs menu. 

 

10.6.1 Select the Detector Type 

The XRD Commander program window is separated into five pages. 

1. Use the tabs on the bottom of the screen to change the active page (see Figure 10.10.1). 

2. Select detector type PSD (LynxEye) in the Details tab. 

 

Figure 10.10.1 Tab selection 

10.6.2 Select the Scan Parameters 

The following parameters must be selected prior to running a measurement: scan type, start, stop, 
speed, and increment (see Figure 10.2 and Figure 10.3). Additional settings may include divergence 
slit size, rotation of the stage, and generator settings for KV and mA. 
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When using a PSD Fixed scan, the maximum scan length may vary and is dependent upon the Config 
geometry angle. 

To perform a measurement: 

1. Turn the X-ray generator on. 

2. Figure 10.2 and Figure 10.3 show the location of the parameters for different immediate 
measurements. The fields show the actual settings for the current measurement. 

 

Figure 10.2 Example of measurement parameters for fixed scan 

 

Figure 10.3 Example of measurement parameters for locked coupled scan 

3. Scan type: Choose the scan type from the drop-down menu. You must select PSD as a detector 
type in the Details tab before PSD Fixed scan is available. 

4. Scan speed: Enter the scan speed here. LynxEye operation uses seconds per step. Click the 
button to the right of the input field to switch between seconds per step and degrees per minute. 
The actual setting will be displayed on the button. 

5. Continuous/Step scan: Click this button to change between continuous or step scan mode. The 
actual setting will be displayed on the button. It is recommended that continuous scan is used to 
reduce wear on the goniometer. 

6. Start, Stop: Use these buttons to begin or end an immediate measurement. 
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10.6.3 Suppression of K� 

During typical operation, suppression of K� is necessary. For this reason, it is important to make sure 
that you are using the proper filter. See Table 10.1 for proper filter selection and the location of the K�1 
peak. In the case of Cu radiation, a Ni filter is included with the LynxEye accessories. For part 
numbers of different filters (material, thickness) see 12 

 

 NOTE 

Do not use K� filters in combination with Goebel mirrors or Primary monochromators! 

 

Table 10.1 Filter selection and angular position [deg] of K�1 peak 

Settings 

Quartz sample 

Anode E (KeV) K�1 K�2 K�1 Beta filter 

Cu 8.048 26.64 26.70 24.033 Ni 

Cr 5.412 40.06 40.13 36.333 V 

Co 6.92 31.04 31.11 28.054 Fe 

      

 

NIST 1976 Corundum Standard 

Cu 8.048 35.15 35.21 31.673 Ni 

Co 6.92 41.05 41.11 37.047 Fe 
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10.7 Calculate the Optimum Detector Optics Settings 
This section describes how to calculate the optimum setting for the PSD angle or the secondary slits 
using LynxEye > Calculate Geometry in the Configuration program CONFIG.EXE. 

1. In the LynxEye Setup menu, click the Calculate Geometry button. The PSD Calculator menu will 
appear (see Figure 10.4). 

 

Figure 10.4 PSD Calculator 



LynxEye Detector User Manual Basic Operation 

DOC-M88-EXX95 V2 – 11.2007 10-9

The values shown in the PSD calculator window are taken from different menus: 

� The measurement diameter is set in the Basic Diffractometer Settings menu 

� The PSD angle is set in the LynxEye menu 

� The PSD resolution and offset were determined during the calibration of the detector 

� The distances of the Antiscatter slit and the Detector slit to the detector window are set in the 
LynxEye menu. The distances are measured from the slit to the focus circle (equal to the sensor 
plane). There is only one value for the Detector slit distance. Three different distances can be set 
for the Antiscatter slit distance related to the length of the antiscatter tube used (for 401 mm, 
435 mm or 500 mm measurement circle diameter). 

2. Set the Preferred Divergence (see Figure 10.4). 

3. Specify either the PSD angle or the Antiscattering Slit Width (e.g. 8 mm in case of using the 
8 mm plug-in slit or any other value when using the Lynx Iris). See Figure 10.4. 

 

 NOTE 

PSD angle, Antiscattering Slit Width and Detector Slit Width depend on each other. Changing one of 
these values will automatically update the others based on the rest of the parameters. 

 

 NOTE 

Optimize the setting in that manner that following conditions are met: Lower Channel > 0 AND Upper 
Channel < 191 ! Due to mechanical tolerances and alignment it might happen that the best usable set 
of channels is not perfectly centered in relation to the sensor. 

 

 NOTE 

When using the Motorized Antiscatter Slit (Lynx Iris) write down the value of the Antiscatter Slit 
Width. This value can be used as the optimized target position of the Lynx Iris in XRD Commander. 
This value is currently (end 2007) NOT set automatically. 
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4. To implement the settings, press the Apply button. 

5. Download the changes to the LynxEye controller to make them effective. 

 

For more detailed information on the operation and use of the XRD Commander measurement 
software, refer to the DIFFRACplus XRD Commander User Manual (M88-Exx060). 
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10.8 Instrument Performance Test 
For a quick performance test of the instrument use the NIST SRM 1976 standard sample and 
determine the resolution of the main peak. The system should match the specifications in Table 10.2 

Perform a 2 degree locked coupled (continuous) scan with the main peak centered (e.g. 
2Theta = 34.15 to 36.15 for Cu radiation). Refer to Table 8.2 for instrument parameters. 

The FWHM (resolution) is determined using the AREA feature of the program DIFFRACplus EVA, 
which is part of the DIFFRACplus Basic package supplied with the diffraction system. To learn how to 
use EVA and its AREA function, refer to the DIFFRACplus EVA User Manual (M85-Exx002). 

Table 10.2 FWHM specifications for Cu radiation 
Cu Bragg Göbel Mirror* 

401 mm � 0.060° � 0.130° 

435 mm � 0.055° � 0.120° 

500 mm � 0.050° � 0.110° 

600 mm < 0.050° < 0.110° 

* parallel beam type 

 

Start EVA and load the RAW data to evaluate. 

1. Open the EVA toolbox (press F2 or the hammer icon) to perform background subtraction and a K�2 
stripping, ensuring a properly adjusted K�1/K�2 ratio to minimize artefacts and a 0.5 intensity ratio. 
Select the Append button to create a new phase. 

2. Use the Area function in the EVA toolbox to create an area measurement using the complete 
measured range (see Figure 10.5). Use the mouse to select the range. 

3. Review the data displayed in Toolbox (see Figure 10.6). 
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Figure 10.5 EVA Main window Figure 10.6 EVA Toolbox 

 

 

 NOTE 

The primary installation and IQ OQ PQ (part number M88-Exx068) may require additional testing for 
instrument verification. 
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10.9 Pulse Height Analysis (PHA) 
Photons are converted to electronic pulses proportional to their photon energy. PHA scans allow to 
check the correct setting of the discriminators with respect to the noise level, the used radiation and 
the inherent resolution of the x-ray tube.  

10.9.1 Perform a measurement 

1. Turn on the X-ray generator. 

2. Choose Pulse Height Analysis from the Scantype drop-down menu. 

3. Preposition the goniometer circles to get a representative reflection of the sample centered on the 
detector. 

4. Figure 10.7 shows an example of a measurement parameter set suitable for a PHA scan using Cu 
radiation and the NIST SRM 1976 standard sample. The fields show the selected settings for the 
measurement. 

 

Figure 10.7 Example of measurement parameters for PHA scan 

5. Start value, Stop value: when doing a PHA scan the measuring unit is V. The default settings for 
the LynxEye discriminator are: 

� Lower level: 0.11 V 
� Width: 0.14 V 
� High level: 0.25 V (calculated from Lower level + Width) 

The values for the lower level and the window width can be checked and modified in the Details 
tab. 

6. Scan speed: Enter the scan speed here. LynxEye operation uses seconds per step. 
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7. Start, Stop: Use these buttons to begin or end an immediate measurement. 
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10.9.2 Determine optimized discriminator settings 

Figure 10.8 shows an example of a PHA scan on a corundum sample using Cu radiation. 

To determine the different discriminator levels move with the cursor along the scan. The x value of the 
cursor position (in V) is shown close to the right bottom of the XRD Commander window. 

The values for the lower level and the window width can be checked and modified in the Details tab. 

 

Figure 10.8 Example of a PHA scan (corundum sample, Cu radiation) 

Noise edge 

Cu response

Default lower level Default high level 
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 NOTE 

To ensure the correct allocation of intensities to the detector channels do NOT set the discriminator 
lower level lower than 1/2 of the level determined for the signal peak maximum! 
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10.10 Detector flood field correction 
The flood field correction is a special feature to improve the LynxEye detector performance for PSD 
Fixed Scans. It might be usable only for some special kind of applications. 

It does NOT influence or alter the characteristics of continuous scans. 

 

 CAUTION 

An improper performed flood field calibration might influence PSD Fixed Scan data! 

 

 

 NOTE 

Enabling/disabling the flood field correction is only possible in CONFIG! As long as the flood field 
correction is enabled in CONFIG it will automatically be applied to all PSD fixed scans. You can check 
the status (enabled/disabled) in the XRD Commander DETAILS tab). 

Please remember that the flood field correction depends on any measurement condition which will 
influence intensity distributions, especially: 
� Alignment 

� PSD Calibration 

� detector HV and discriminator settings 

� measurement circle 

� soller slits 

� … 

You have to perform and analyse a new flood field file whenever measurement conditions have been 
changed. 
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1. Optimize the Detector Optics Settings (see Section 10.7). Note the resulting PSD Angle. 

2. Make sure that the flood field correction is disabled (see Figure 10.9and Figure 10.10) 

 

Figure 10.9 Access the flood field option in Config 
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Figure 10.10 Flood field correction disabled 

3. Save/download the configuration and quit/restart all other measurement programs. 

4. In XRD Wizard create a DQL-file using following measurement conditions: 

� Geometry angle: PSD Angle as noted before (see 1.) 

� Divergence slit: 1° / 2 mm 

� Primary soller: 2.5° 

� Secondary soller: 2.5° 

� K� Filter: removed 

� Generator: 40 kV / 50 mA 

� Scan type: PSD fixed scan 

� Speed/Time: 300 sec 

� Resolution: 0.006 

� Range: see note 

� Rotation (if possible): 15 rpm 
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 NOTE 

The range depends on the sample you are using for getting a homogeneous background radiation. 
When using a standard steel sample holder (mounted upside down) a fixed scan from 100° to 
(100 + PSD Angle)° 2Theta may be a recommended selection for Cu radiation. 

 

5. Save the DQL file as “floodfield.dql” and exit XRD Wizard. 

6. Open XRD Commander and create a job using the “floodfield.dql” file. 

 

 NOTE 

Make sure that MeasureV4.VBS is selected as the script to be used. 

 

7. Name the Raw file “floodfield.raw” and start the job. 

8. After finishing the job go to the flood field correction option in CONFIG (see Figure 10.9), enable 
the flood field correction and import the “floodfield.raw” file (see Figure 10.11). 
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Figure 10.11 Enable correction and import RAW-file 

 

9. Confirm with OK, Save/Download the configuration and quit/restart all other measurement 
programs. 

 

 NOTE 

As long as the flood field correction is enabled access to the discriminator levels is disabled. To 
change these detector parameters the flood field correction has to be disabled in CONFIG. 
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11 Preventive Maintenance and Troubleshooting 

The components of the diffractometer are basically maintenance-free for the user. However, Bruker 
AXS recommends a yearly preventive maintenance inspection. To schedule this inspection or for 
technical support, contact your local Bruker AXS Service Department. 

 

 NOTE 

For standard maintenance and troubleshooting there is no need to open any of the LynxEye 
components. Especially breaking the seal of the detector cover and/or removing the detector cover will 
lead to a complete loss of warranty! 
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11.1 Cleaning the Diffraction System and Measuring Equipment 
 
 CAUTION 

In preparation of a cleaning of the instrument please shut down the complete diffraction system (i.e., 
all control electronics, accessory components, and the high voltage generator). 

 

 

 WARNING 

Do not touch the front window of the X-ray tube as it contains beryllium. Beryllium is potentially 
hazardous if ingested, inhaled or absorbed through the skin. Never drill, grind or sand beryllium unless 
you are a qualified individual using appropriate respiratory equipment and dust containment and 
collection apparatus. Disposal of parts containing beryllium must comply with all applicable national 
regulations. 

 

To clean the interior of the enclosure and exterior of the detector components, use dry cleaning 
utensils only. Do not use water or aggressive cleaning agents. Clean laboratory conditions are 
recommended. Airflow is critical for maintaining proper operation of the detector control electronics. Do 
not place anything on the controllers that may restrict the flow of air. Regular cleaning of the detector 
components includes removal of any airflow restrictions, including dust. 
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11.2 Replacing Fuses 
1. Unplug the power cord before replacing the fuse. 

2. Locate the fuse at the rear side of the controller. 

3. Carefully remove the fuse from its holder. You may need a small screwdriver or needle-nose pliers 
to pry open the fuse cover (see Figure 11.1). 

 

 NOTE 

Replace the fuse only with the specified replacement (see 12). Do not substitute a fuse with a different 
rating. 
 

4. Insert the new fuse into the holder. Verify complete seating of the new fuse. 

5. Replace the fuse cover. 

6. Plug in the power cord. 

If the controller continues to blow fuses or if any function does not work correctly after replacing the 
fuse, contact Bruker AXS Service for repair assistance. Discontinue use of the controller if it is not 
functioning properly. 

 

Figure 11.1 Fuse close-up 
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11.3 Troubleshooting 
 

11.3.1 Display data in the XRD Commander window has flatlined or 
is nonexistent. 

� Ensure that the detector type PSD is selected in the Details tab of the XRD Commander program. 

� Check if the BIAS button is illuminated. 

� Check if the motor clock cable is properly installed (see Figure 3.6 and Figure 6.1). 

 

11.3.2 System Activity LED not flashing 

� Reset the LynxEye controller. If the system activity LED still remains off switch off the LynxEye 
controller, check the cable connections to the detector and restart the controller. 

� Connect a serial cable and attempt to recover communications from the Config program (see 
Section 11.4). 

 

11.3.3 Alarm LED lights red, Low Voltage Ready LED remains off 

� Check the cables and the cable connections to the detector and restart the controller. 

 

11.3.4 The BIAS button is not illuminated. 

� Press the BIAS button. If the switch lights, the Bias is enabled. If the switch is still not lit, check the 
Power ON switch on the LynxEye controller or D8 base cabinet. 

� Use a continuity checker or ohmmeter to verify the condition of the fuse. Visual inspection is not a 
reliable method for determining the fuse condition. If you do not have access to one of the above 
instruments, replace the suspect fuse with a new fuse (see Section 11.2).
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11.3.5 There is no communication to the system and the following 
error appears: “Time Out Reading from Socket.” 

� Check the network cable connections and network card. 

� Check the network settings in the Config program file. 

� Check the configuration of the 2nd network adapter “LAN 2” in the PC. 

� Connect a serial cable and attempt to recover communications from the Config program (see 
Section 11.4). 

 

11.3.6 The angular accuracy peak position data is larger than +0.01° 
of the expected value. 

� Repeat the calibration of the LynxEye detector (see Section 8.2). 
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11.4 Manual Configuration of the Controller 
If there is no communication to the D8 controller, power-up the LynxEye controller using the following 
procedure. 

1. In the Config software, go to PSD-Controller. Check for correct settings as described in Section 
6.6. Press the “Recover…” button located in the lower left corner of the window (see Figure 6.15). 
A new window will pop up (see Figure 11.2). 

2. Follow the steps in the screen shown in Figure 11.2. 

3. Select COM1 in the drop-down list and press Continue. Another window appears indicating that 
Config is now waiting for the controller to boot up. 

 

 

 

Figure 11.2 Recover pop-up window Figure 11.3 Boot-up window 
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4. Switch on the controller and wait a few minutes. As soon as the controller becomes ready, Config 
transmits the configuration file. 

5. A message will pop up stating that transmission is successful. Switch off the LynxEye controller. 

6. Replace the cables as they were prior to this recovery procedure (see Figure 6.1). 

7. Switch on the LynxEye controller. 

Communication is now back via the LAN line. 
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12 Spare Parts List 

Table 12.1 Spare parts 

Part Number Description 

A17D60 LynxEye detector for D8 ADVANCE/D8 DISCOVER, incl. controller, mount required 

A17D61 LynxEye detector for D8 FOCUS/D4 ENDEAVOR, incl. controller and mount 

A17B60 LynxEye detector only 

A17B80 Controller for LynxEye detector 

C79298A3244B122 Spacer/long for 150 mm (used as the mount for the LynxEye) 

C79298A3244B123 Spacer/long for 214 mm (used as the mount for the LynxEye) 

C79298A3244B127 Spacer/long for 258 mm (used as the mount for the LynxEye) 

A17B81 0/90° Mount and spacer for 150 mm LynxEye (D8 ADVANCE and Discover only)  

A17B82 0/90° Mount and spacer for 214 mm LynxEye (D8 ADVANCE and Discover only)  

A17B83 0/90° Mount and spacer for 258 mm LynxEye (D8 ADVANCE and Discover only)  

A17D62 set of plug-in slits (3.0, 8.0 mm) for LynxEye detector (included in delivery) 

A17B85 plug-in slit for LynxEye, 8 mm 

A17B86 plug-in slit for LynxEye, 3 mm 

A17B61 Axial Soller slit 2.5° for LynxEye detector (included in delivery) 
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Part Number Description 

A17B67 Axial Soller slit 1.5° for LynxEye detector 

A17B68 Axial Soller slit 4° for LynxEye detector 

A17B70 Motorized Antiscatter Slit (Lynx Iris) 

A17B72 Ni-filter for Cu-Kß-radiation, 2.5%, for LynxEye detector 

A17B73 Fe-filter for Co-Kß-radiation, 2.5%, for LynxEye detector 

A17B74 V-filter for Cr- Kß-radiation, 2.5%, for LynxEye detector 

A17B76 Ni-filter for Cu-Kß-radiation, 0.5%, for LynxEye detector (included in delivery) 

A17B77 Fe-filter for Co-Kß-radiation, 0.5%, for LynxEye detector 

A17B78 V-filter for Cr- Kß-radiation, 0.5%, for LynxEye detector 

A17B53 Cu-Absorber 0.1 mm, for LynxEye detector 

A17B88 Antiscatter tube 500mm 

A17B89 Antiscatter tube 401mm 

A17B90 Antiscatter tube 435mm (included in delivery) 

A17B63 Cable Guide LynxEye D4 

A17D77 Detector Power cable 

A17D78 Detector Data cable 

A17D42 Clock cable  

A17D43 Y-cable for clock cable A17D42 (only required for AIB 104/105) 



LynxEye Detector User Manual Spare Parts List 

DOC-M88-EXX95 V2 – 10.2007  12-3

Part Number Description 

A17D79 Multi axes clock cable for D8 ADVANCE and D8 DISCOVER, or Super Speed Solutions 

C72298A251B39 Ground Cable for FC (S3K) 

K340C9 Ethernet Crosslink cable 50 Ft (15 m) 

K360C2 Network card 

W79054L1011T400 Fuse T 4,0A / 250V 
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13 Updating the Detector Controller Firmware 

The Bruker AXS LynxEye detector controller is running Linux as its embedded operating system. The 
operating system itself and all associated control software are stored on a Flash drive inside the 
controller. This section describes how to update the firmware on the detector controller’s Flash drive. 

 

 CAUTION 

An improper software installation might result in a loss of functionality or performance of the LynxEye 
detector. In case of any doubts about usable software versions or the installation process please 
contact your local Bruker AXS Service Department 

 

A.1. Setting up the HTTP connection 
To access the detector controller with a Web browser, the user needs a login name and password. To 
set up the login and password: 

1. Open the Diffractometer Configuration program and go to Basic Diffractometer Settings > 
Advanced Board Setup > PSDController > IP Setup and Services. Check the HTTP Interface 
checkbox and press the Users button. 

 



Updating the Detector Controller Firmware LynxEye Detector User Manual 

 DOC-M88-EXX95 V2 – 10.2007 13-2 

 

Figure 13.1 Set up login and password 

2. Click Add User (see Figure 13.2). 

3. Fill in the fields in the Add User window as follows: 

User: customer (for example) 
New Password: DIFFRAC (for example) 
Type your new password again in the “Confirm Password” field. 

Check the Status and Service checkboxes (see Figure 13.3). 
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Figure 13.2 List of HTTP Users menu Figure 13.3 User and password setup under 
Add User 

 

4. Click OK. 

5. Save and download the configuration. From the menu bar at the top of the Diffractometer 
Configuration window, go to File > Save and Download. 

6. A confirmation window appears (Figure 13.4). Click Yes. 

 

 

Figure 13.4 Save changes confirmation window 
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7. Upon saving, the software intelligently decides whether it needs to download the configuration 
information to the diffractometer. A window appears showing whether the software will do this or 
not (in Figure 13.5, the configuration will not download). Accept the default and click OK. 

 

 

Figure 13.5 Download configuration window 
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A.2. Performing the Flash Disk Installation 
In order to update the embedded Linux system on the Flash drive, do the following: 

1. Open your preferred Web browser. 

2. Browse the x86 based CPU-Board or PC by typing the detector controller’s IP address into the 
address field of your browser: 

http://192.168.23.2 

 

 NOTE 

If you are using a local proxy server, make sure the detector controller’s IP address is excluded by 
entering it as an exception in your Web browser’s Proxy Settings menu. For Internet Explorer, go to 
Internet Explorer > Tools > Internet Options > Connections > LAN Settings > Advanced. See 
Figure 13.6. 
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Figure 13.6 Entering the detector controller’s IP address as a Proxy server exception 

3. After typing the detector controller’s IP address, hit Enter. The detector controller prompts you for a 
user name and password. 

4. Enter user name and password that have been defined in Section A.1 and click OK (see Figure 
13.7). 

5. The detector controller menu appears in the browser window (see Figure 13.8). 
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Figure 13.7 Enter Password Figure 13.8 Browsing the x86-based CPU 
board or PC 

 

6. Select the Update System link from the menu. The System Update page will appear on the right 
side of the window. 
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Figure 13.9 System update package dialog 

 

7. Choose the Browse button and select the update package with the extension *.tgz . 

 

 NOTE 

Update vs. Complete (Re)Installation: The “Update” variant (recommended) leaves intact all 
configuration files stored on the Flash drive, whereas “Complete (Re)Installation” formats the Flash 
drive before installing, discarding all configuration files. 

 

8. Press the Proceed button to begin the update process. It should take about one minute. 

9. When finished, a report about the installation process will be displayed. 

10. The update of the PSDWARE is now complete. 

11. To activate the update, reboot the detector controller by switching it off, waiting 5 seconds, and 
switching it on again. After rebooting, the detector controller should be reachable with your Web 
browser at the same IP address. 
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